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RESUMEN 

 

Con la realización de la presente investigación se pretende demostrar la importancia 

del estudio de las cuencas hidrográficas y su relación con el riego agrícola, además 

de proporcionar una herramienta importante para gestionar  adecuadamente  el 

recurso más vital para el ser humano.  

Se utilizó modelos digitales de terreno, MDT (Aster Gdem) y GPS y se aplicó las 

técnicas de observación, registro de datos, medición, análisis documental y cálculo. 

El área de estudio se encuentra ubicada en la provincia de Cotopaxi cantón 

Latacunga ubicado a una Latitud 0°56′00″S Longitud 78°37′00″O 

Entre los  resultados se determinó la superficie de la cuenca alta, cuenca media y 

cuenca baja. La superficie para la cuenca alta es de 1105,87 ha lo que corresponde 

al 0,8%. Para calcular la longitud del río principal se utilizó una calculadora de 

raster disponible en programa ARC GIS y  con la utilización de un TIN  se calculó 

el área que se lograría inundar en la cuenca principal del cantón Latacunga. Dicha 

superficie es de 3195956,26 m3, lo que corresponde  al 77% del manejo total de la 

cuenca en la que está ubicada el cantón Latacunga,  teniendo en consideración que 

la precipitación mensual para adquirir el volumen de la cuenca expresada es de 

11541 mm, con una efectividad neta en el embalse de 0,19% 

DESCRIPTORES: 

TIN, Raster, Pixel, volumen hídrico, subcuenca 

http://tools.wmflabs.org/geohack/geohack.php?language=es&pagename=Latacunga&params=-0.93333333333333_N_-78.616666666667_E_type:city
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ABSTRACT 

 

With the completion of this research is to demonstrate the importance of studying 

watersheds and their relationship with agricultural irrigation, as well as providing 

important to properly manage the most vital human resource tool. 

Digital terrain models, MDT (Aster Gdem) and GPS was used and observation 

techniques, data logging, measurement, analysis and calculation documentary was 

applied. The study area is located in the province of Cotopaxi Latacunga Canton 

located at latitude 0 ° 56'00 "S Longitude 78 ° 37'00" O 

Among the results the surface of the upper, middle and lower basin was determined. 

The surface for the upper basin is 1105.87 has corresponding to 0.8%. raster 

calculator available in ARC GIS program and the use of a TIN area would be 

achieved flooding in the main basin of Latacunga Canton was calculated was used 

to calculate the length of the main river. This surface is 3,195,956.26 m3, 

corresponding to 77% of the total watershed management in the canton Latacunga 

is located, taking into consideration that the monthly precipitation to acquire the 

volume of the said basin is 11541 mm, with a net effectiveness in the reservoir of 

0.19% 

 

DESCRIPTORS: 

 

TIN, Raster, Pixel , water volume , sub-basin 
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INTRODUCCIÓN 

 

Breve descripción de la estructura de los capítulos de la Investigación.  

 

El proyecto de investigación: Recursos hídricos y uso agrícola geolocalización de 

los recursos hídricos en el cantón Latacunga-provincia de Cotopaxi 2015. Su 

importancia radica en que permitió determinar la sub cuenca del rio Cutuchi, Está 

estructurado por capítulos: 

 

EL CAPÍTULO I, este capítulo aborda el marco Contextual y teórico, realiza una 

caracterización detallada de la sub cuenca, antecedentes investigativos 

fundamentación de la investigación, fundamentación legal y bases teóricas 

científicas que sustentan la investigación.  

 

 

EL CAPÍTULO II, En este apartado se realiza la validación teórica de la 

investigación propuesta, así como las técnicas y métodos de investigación aplicados 

para establecer los datos y procesarlos, asocia las variables en estudio. 

 

EL CAPÍTULO III, se análisis e interpreta y presenta los resultados de la 

investigación, en torno a los datos obtenidos.  

 

EL CAPÍTULO IV, este apartado determina la Propuesta de Manejo de la sub 

cuenca del rio Cutuchi del cantón Latacunga, presentes en las áreas de estudio, 

conforman, datos informativos, Título, Justificación, Objetivos, Estructura de la 

propuesta, Desarrollo de la propuesta 

 

EL CAPÍTULO V, está conformado por las conclusiones y recomendaciones de la 

investigación del problema planteado. Se concluye con la bibliografía utilizada y 

los anexos. 
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Situación Problémica 

 

El agua es un recurso de gran importancia para la economía y sociedad. La 

preocupación del presente trabajo gira en torno a los problemas de la disponibilidad 

de agua de riego en la provincia de Cotopaxi, donde existe una creciente demanda 

por el recurso hídrico, entre otras cosas, para la actividad agrícola. 

 

Esta demanda es generada por una actividad agrícola muy dinámica, principalmente 

orientada a la exportación de rosas y brócoli que son cultivos que requieren agua  

en altos cantidades. La demanda creciente de agua por parte de los sectores 

productivos y la expansión de las ciudades en un contexto de cambio climático 

vienen ejerciendo una gran presión sobre la generación y distribución del recurso 

hídrico. 

 

El crecimiento económico y poblacional que experimenta la sociedad en los últimos 

años requiere de mayor disponibilidad de agua. Sin embargo, el agua tiende a ser 

cada vez más escasa con respecto a las zonas geográficas o territorios donde se 

expanden las actividades económicas y productivas, y donde también se incrementa 

la población. 

 

Según la base de datos de concesiones de (SENAGUA, 2011) en las demandas 

sectoriales, el uso consuntivo predominante en el país es el agrícola, pues representa 

el 80% del caudal utilizado, seguido por el uso doméstico (13%) y la industria (7%).    
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Gráfico 1 Distribución de los usos consuntivos en el Ecuador 

 

Fuente: Base de datos de Concesiones SENAGUA, 2011 

 

En los informes internacionales (FAO, 2002) el Ecuador está ubicado a nivel 

mundial en el puesto 33, en relación a la cantidad de agua disponible por persona, 

situación que debería preocupar a las autoridades encargadas del recurso hídrico. 

 

Justificación 

 

El presente trabajo sobre la delimitación de la sub cuenca del rio Cutuchi 

perteneciente al cantón Latacunga es de gran trascendencia ya que la conservación 

del recurso hídrico es realmente importante en la iniciativa de desarrollo sostenible 

en el Ecuador, basada en la gestión integrada de un conjunto de actividades 

normativas, administrativas, operativas y de control, estrechamente vinculadas, que 

deben ser ejecutadas por el Estado y la sociedad en general, para garantizar el 

desarrollo y óptima calidad de vida de los habitantes en el espacio geográfico 

respectivo de cada cuenca hidrográfica, poniendo énfasis en la conservación, que 

promueve, como parte de ella, el uso sustentable de los recursos suelo, agua y 

cubierta vegetal. 
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Frente a los problemas y limitantes que enfrenta el manejo de cuencas, además se 

propone contribuir a mejorar la planificación y acción, sustentadas en los elementos 

centrales del manejo de la sub cuenca que es el agua 

 

La Constitución de la República aprobada en referéndum del 28 de septiembre de 

2008, publicada en el Registro Oficial No. 449 de 20 de octubre de 2008, en su 

primera disposición transitoria, inciso segundo establece que en el plazo máximo 

de tres cientos sesenta días, entre otras se aprobará la "ley que regule los recursos 

hídricos, usos y aprovechamiento del agua, que incluirá los permisos de uso y 

aprovechamiento, actuales y futuros, sus plazos, condiciones, mecanismos de 

revisión y auditoria, para asegurar la formalización y distribución equitativa de este 

Patrimonio". 

 

Fuente especificada no válida.  

El agua es parte del ambiente y como tal, no puede ser entendida de otra manera 

que no sea como elemento integrado e integrador del ambiente. 

La muestra de movimiento y recorrido del agua por el planeta lleva a postular la 

idea de que este elemento vital para realizar las interacciones con todos los 

componentes ambientales.  

Sin embargo, es un bien escaso si bien  el 70 % de la superficie del mundo está 

cubierta por agua, solamente el 2.5% es dulce, mientras que el restante 97.5% es 

agua  

 

Objeto y Problema 

 

El objeto de estudio para la presente investigación es la Cuenca alta del rio Pastaza 

y la influencia en el área agrícola. 
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El cuidado y protección de los recursos hídricos es un tema que día a día cobra 

mayor importancia por la problemática de la degradación de este importante.  Por 

esta razón, el manejo de los recursos hídricos en el marco de las cuencas 

hidrográficas con  alternativas económicas, sociales y ambientalmente viables 

representa una vía idónea no solo para aprovechar racionalmente estos recursos sino 

también, para la mitigación y reducción de la vulnerabilidad ante los desastres 

naturales. Como la cuenca hidrográfica es un escenario dinámico integrado por 

recursos naturales, infraestructura, medios o servicios y   actividades que desarrolla 

el hombre que generan efectos positivos deben considerarse los peligros y riesgos 

ante eventos extremos y fenómenos naturales severos. 

 

El servicio de agua es deficiente dentro del cantón Latacunga para el sector agrícola, 

teniendo en consideración que  el sistema no es sostenible porque no hay suficientes 

recursos para un buen servicio y mantener una adecuada planificación. Faltan 

recursos y capacidad para una buena operación y mantenimiento, por parte de cada 

uno de los GAD’s  Es un círculo vicioso, porque no hay recursos porque los usuarios 

no quieren o no pueden pagar para un mal servicio. Además, existe poca voluntad 

política para aumentar las tarifas. La mala calidad del servicio de agua 

principalmente de riego afecta relativamente más a las personas vulnerables en la 

población. En sistemas de riego con una distribución de agua informal son también 

los usuarios vulnerables con poco poder social que sufren más. 

 

En sistemas de riego, a menudo, tampoco hay suficiente recaudación de fondos para 

una operación y mantenimiento óptimo. Para revertir el círculo vicioso se debe 

revertir la cadena negativa en una cadena positiva. Es decir con suficiente 

recaudación de tarifa y se puede brindar un buen servicio, y con un buen servicio 

los usuarios estás dispuestos de pagar la tarifa. Esto solo se puede lograr con 

intervenciones simultáneas en diferentes partes de la sub cuenca, entregando agua 

de calidad para una mejor producción. 
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Campo de Acción 

 

El campo de investigación de dicha investigación se basa en la Gestión de recursos 

naturales. 

 

Objetivo General 

 

Determinar el volumen total de la sub cuenca del río Cutuchi para riego agrícola 

mediante imágenes satelitales en el Cantón Latacunga 

 

Objetivos Específicos 

 

➢ Calcular el volumen de agua disponible para riego agrícola  dentro de las 

sub cuencas del rio Cutuchi perteneciente al cantón Latacunga 

 

➢ Aplicar una metodología de geolocalización de los recursos hídricos 

mediante imágenes satelitales. 

 

➢ Diseñar una propuesta de manejo integrado de la sub cuenca del rio Cutuchi 

 

 

 

 

 

 

 

 

 

 

 



 

7 

 

Sistema de objetivos específicos 

 

Tabla 1: Sistema de objetivos específicos con tareas 

OBJETIVO 
TAREAS PROCEDIMIENTO 

Calcular el 

volumen de agua 

disponible para 

riego agrícola  

dentro de las sub 

cuencas del rio 

Cutuchi 

perteneciente al 

cantón Latacunga 

Calculo de 

volumen de agua 

en la sub cuenca  

Dentro de la opción Hidrology del 

programa arc gis 

Aplicar una 

propuesta de 

geolocalización de 

los recursos 

hídricos mediante 

imágenes 

satelitales. 

Descargar MDT ( 

Modelos Digitales 

del Terreno ) 

Elaborar una fusión de los Modelos 

Digitales de Terreno en el Programa 

Arc Gis 

Utilizar las herramientas presentes en el Hidrology del 

Arc Gis 

Fill 

Rellenar las imperfecciones existentes 

en la superficie del modelo digital del 

Terreno 

Flow Direction 

Se determinó la dirección del flujo 

buscando el camino descendente de una 

celda a otra 

Flow 

Acumulation 

Se crea el raster de acumulación de 

flujo en cada celda 

Stream definition 

En esta fase se clasifican las celdas con 

acumulación de flujo superior a un 

umbral especificado por el usuario 

como celdas pertenecientes a la red de 

flujo 

Stream Order 

Procedemos a crear un raster del orden 

de las corrientes, con el método 

Strahler. 

Stream Feature 
En esta fase determinamos el shape de 

drenajes 

Feature Vertice 

To Point 

Esta herramienta permite determinar los 

puntos donde se cortan cada uno de los 

drenajes, es decir convierte los vértices 

a punto 

Watershed 

Delineation 

Aquí delinea una sub cuenca por cada 

uno de los segmentos de cauce 

definidos en el paso anterior 
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Alcance 

 

En la presente investigación se ha llegado a determinar la  geolocalización de los 

cauces que presentan la sub cuenca con modelos digitales de terreno, y el cálculo 

del volumen que obtenemos en metros cúbicos, para que sirva a los GAD’s para 

planificar el agua necesaria para riego en el cantón.    

 

Visión epistemológica de la investigación 

 

Dentro del estudio que se realizó se utilizó la investigación descriptiva, en el cual 

se describe como un método científico que implica observar y describir el 

comportamiento de un sujeto sin influir sobre él de ninguna manera. (Shuttleworth, 

2008) 

 

La investigación descriptiva se aplicó para describir cada uno de los cauces de la 

sub cuenca principal, del Río Cutuchi perteneciente al cantón Latacunga y se 

calculara la longitud de los ríos. 

 

Aquí también se utilizó la investigación exploratoria, la cual consiste en estudios 

descriptivos la cual busca especificar las propiedades importantes de personas, 

grupos, comunidades o cualquier otro fenómeno que sea sometido a análisis. 

(Shuttleworth, 2008)  

 

Para la investigación exploratoria se determinó el volumen de agua producido por 

la sub cuenca del  río Cutuchi perteneciente al Cantón Latacunga, utilizando las 

precipitaciones anuales y mensuales, del año 2015 de Word Clim 
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Durante la investigación debemos tener en cuenta la geolocalización de los cauces 

que presentan la sub cuenca mediante la utilización de los MDT (Aster Gdem), 

además de la gestión de cuencas hidrográficas que ha ido evolucionado pasando por 

diversas etapas de desarrollo, durante  las primeras, etapas debe formar parte de la 

silvicultura, agricultura y de la hidrología, también a la participación de la 

población no se tenía en cuenta, durante todo la gestión de cada uno de los GAD´s  

 

 

Métodos, procedimientos y técnicas de Investigación  

 

El método de investigación que sustenta esta investigación es el método hipotético-

deductivo el cual según varios epistemólogos, es el procedimiento o camino que 

sigue el investigador para hacer de su actividad una práctica científica. Las 

características de esta investigación permitieron la realización de los cálculos 

necesarios para determinar la cantidad de agua presente en la sub cuenca del rio 

Cutuchi y medir la longitud de los cauces principales que forman dicha sub cuenca  

 

Tipo de Investigación  

 

En el presente trabajo se realizó “una investigación que mediante los procesos 

cuantitativo; se analizó profundamente una unidad de la sub cuenca para responder 

al planteamiento del problema,” (Hérnandez, 2006) “las investigaciones 

descriptivas utilizan criterios sistemáticos que permiten poner de manifiesto la 

estructura o el comportamiento de los fenómenos en estudio, proporcionando de ese 

modo información sistemática y comparable con la de otras fuentes”, con esto 

determinamos que nuestra investigación es descriptiva porque nos ayuda a 

determinar las sub cuenca alta media y baja del cantón Latacunga así como también 

los cauces que forman cada una de las sub cuencas. 

 

Además de la investigación es exploratoria,  se realiza cuando el objetivo consiste 

en examinar un tema poco estudiado (Hérnandez, 2006), como es el estudio de las 

cuencas y sub cuencas mediante la utilización de los sistemas de información 
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geográficos, temática que no ha sido tratada con la suficiente seriedad del caso que 

es el agua para la producción agropecuaria. 

 

Técnicas e instrumentos para la recolección de datos.  

 

Las técnicas que se consideran más adecuadas para el desarrollo de la presente 

investigación es:  

 

Observación  

 

Para (Herrera, 2004) Existen cinco tipos de observación: Directa cuando el investigador 

se pone en contacto cercano, Participante cuando el investigador comparte la vida en 

grupo estudiado y Estructurada cuando es planificada en todos los aspectos, métodos y 

es críticamente realizada y se registran con instrumentos técnicos especiales. Bajo esta 

concepción nuestra investigación toma en cuenta la Observación estructurada pues 

utilizaremos instrumentos técnicos especiales, así como software especializados para 

el caso en la delimitación del sub cuenca principal. 
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CAPÍTULO I 

1. Marco Contextual y Teórico 

1.1. Caracterización 

 

Según la (FAO, Cuencas hidrograficas en el ecuador, 2002) expresa que: Esta 

vertiente está formada por la afluencia de numerosos ríos ecuatorianos que nacen 

en la cordillera Oriental de los Andes y en la cordillera Amazónica (Tercera 

Cordillera) ecuatoriana. Principalmente se caracterizan por ser caudalosos y 

navegables en casi todo su curso. Se destacan en dicha vertiente los ríos: 

1.2. Cuenca Pastaza 

 

Formado por la unión de los ríos Patate y Chambo, que se originan en los deshielos 

del Cotopaxi, Illiniza, Chimborazo y Carihuairazo. Luego de abrir una profunda 

brecha en la cordillera central Andina, forma el gran salto del Agoyán, para 

continuar en el Oriente, donde se convierte en un manso río de llanura. (ESCOBAR, 

2003)   

1.3.Cuenca Río Napo 

 

El río Napo es un largo río sudamericano que recorre buena parte de los territorios 

amazónicos de Ecuador y del Perú, uno de los principales afluentes directos del río 

Amazonas en su curso alto. (ESCOBAR, 2003) 

Cuenca Hidrográfica: 100518 Km2 

Longuitud: 1075 Km 

Caudal: 6.976 m3/s 

Boca: Río Amazonas 

Nacimiento: Volcán Antisana, Volcán Cotopaxi. 
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1.4. Sub Cuenca Del Rio Cutuchi 

Cuenca alta del rio Pastaza, Provincia de Cotopaxi 

Cantones: Saquisili, Pujili, Latacunga, Salcedo, Pillaro 

Área: 2680 Km2 (CADENA, 2009) 

GEOMORFOLOGÍA 

Acciones tectónicas y volcanismo andino: potente deposito lahartico; bloques 

cantos rodados y guijarros, matriz arcillosa (CADENA, 2009) 

METEOROLOGÍA 

CLIMA: Zona Tropical Ecuatoriana 

Zona occidental: Peridod invernal de serranía: Octubre a mayo 

Zona Oriental: Periodo Invernal de Amazonia: junio a septiembre (Rio Yanayacu) 

(CADENA, 2009) 

TEMPERATURAS: -3 a 12 °C sobre 3000 msnm 

Temperaturas medio mensual: Min 7,4°C, Max. 14,8°C (CADENA, 2009) 

PRECIPITACIÓN MEDIA ANUAL 

Sub cuenca Cutuchi: 805 mm 

Sub cuenca Chalupas: 1888 mm 

Sub cuenca Yanayacu: 2386 mm (CADENA, 2009) 

EVAPORACION: Max. Julio a Agosto 

Zona Alta mayor 3580 msnm 894 Pisayambo 

Zona Central Mayor 2000 msnm 1493 Rumipamba de las Rosas (CADENA, 

2009) 

VIENTO 

Dirección predominante: S-SE Velocidad 3.8 Km/h 
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HIDROLOGÍA 

Caudal medio: 5.2 ,3/s 

Rendimiento: 12.7 L/l/Km2 

Crecida anual a 10 años: 100 m3/s 

Aguas subterráneas: 1800 Hm3 (acuífero estimado) 

Caudal estimado de explotación: 3 m3/s (CADENA, 2009) 

 

1.5.Marco Teórico 

 

1.5.1. Caracterización de la cuenca 

 

Ecuador es un país caracterizado por la heterogeneidad de su territorio y de su 

población. Con pocas características en común, la población ecuatoriana se 

distribuye espacialmente en forma desproporcionada ocasionando mucha presión 

sobre los recursos naturales en algunas zonas, mientras que en otras prácticamente 

no existe población activa. En este marco, la división política del país, basada en 

provincias y municipios, ha demostrado ser ineficaz para lograr un adecuado 

manejo de los recursos naturales, mostrando que una misma unidad política incluye 

partes de diferentes ecosistemas que a la vez comparte con otras unidades políticas. 

(FAO., 2005). 

 

Los sistemas hidrográficos aportan con un escurrimiento superficial de 432,000m³, 

de los cuales 116 Hm³ (27% del total) corresponden a la vertiente del pacífico donde 

habitan el 80% de la población del Ecuador y 316,000 Hm³ (73% el total) 

corresponde a la vertiente del Amazonas. 
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En la Región Interandina están las cuencas altas y de montaña en donde se asienta 

más del 50% de la población del país. Estás cuencas son de vital importancia porque 

son fuentes de nacientes de agua, yacimientos de minerales, áreas paisajísticas 

andinas para el ecoturismo y en las faldas de las cuencas de montaña se desarrollan 

cultivos agropecuarios, abasteciendo de alimentos al 45% de la población del país. 

(FAO., 2005) 

 

1.5.1.1.Concepto de cuenca 

 

El concepto de cuenca desarrollado por el uso del agua, hoy es componente de 

muchas disciplinas del conocimiento, entre ellas la ecología. En la práctica y 

dependiendo de su grado intervención  con actividades agropecuarias, la cuenca se 

ha transformado en un  agro ecosistema.  Esta  se presta para el estudio de 

ecosistemas naturales, como unidad para la planificación, para la gestión del 

desarrollo, la cuenca hidrográfica es toda el área que genera escorrentía aguas arriba 

de un punto de referencia en el cauce principal. 

Un concepto emitido por (ESCOBAR, 2003) en el Tercer Congreso 

Latinoamericano de Manejo de Cuencas Hidrográficas, señala que “la cuenca no es 

solo un ámbito geográfico, ella acoge una población humana que aprovecha los 

recursos que hay en ella, ese uso genera a menudo conflictos en un escenario que 

es social y económico y que requiere también mecanismos de concertación. En este 

sentido, la cuenca debe ser considerada como una unidad de planificación, en ella 

los habitantes deben ser los actores protagónicos y sus organizaciones comunitarias 

deben constituirse en la base del desarrollo local“. 

Las cuencas hidrográficas han sido consideradas, como las unidades o espacios 

geosociales y políticos más adecuados para la planificación y desarrollo, aunque 

como la historia y literatura lo demuestran, su mayor énfasis se ha orientado hacia 

temas de carácter hidrológico. De allí, la importancia para el ordenamiento y 

manejo con fines energéticos  y de provisión de agua para consumo humano y para 

riego, relegándose a un segundo plano el tratamiento de los elementos biológicos y 
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la participación de los actores locales que dependen o interactúan con los recursos 

de estas áreas, vivimos en el planeta  acuático o del agua, y este recurso dador de 

vida cubre cerca del 71% de su superficie.  Esta preciada envoltura de agua (en su 

mayor parte agua salada y el resto agua dulce) ayuda a mantener el clima de la 

tierra, diluye los contaminantes y es especial para toda forma de vida. (Moncayo., 

2011). 

1.5.1.2.Cuenca Hidrográfica y Cuenca Hidrológica 

 

Según el concepto de ciclo hidrológico, toda gota de lluvia que cae al suelo, 

continua en forma de escurrimiento e infiltración, luego va a lugares de 

concentración, allí parte se evapora y vuelve al espacio para formar el ciclo. 

Luego que la gota de lluvia se infiltra, satura el suelo, pasa a percolación profunda 

y recarga los acuíferos. En este desplazamiento vertical, el agua se puede encontrar 

con estratos impermeables (rocas duras) que movilizarán las partículas de agua 

dependiendo de la forma y tipo de rasgos geológicos. (CATIE, 1985) 

Cuando el relieve y fisiografía, tienen una forma y simetría diferente a la 

configuración geológica de la cuenca, se puede decir que existe una cuenca 

subterránea, que cambia la dirección del flujo sub superficial para alimentar a otra 

cuenca hidrográfica. A ésta configuración se denomina cuenca hidrológica, la cual 

adquiere importancia cuando se tenga que realizar el balance hidrológico. (CATIE, 

1985) 

Cuando la divisoria de la cuenca hidrográfica es diferente de la divisoria de la 

cuenca hidrológica, los flujos sub superficiales y el movimiento del agua en el suelo 

se presenta de la siguiente ilustración 
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Gráfico 2: División Hidrográfica de la cuenca 

 

 

Fuente: CATIE 2010 

1.5.1.3. Sub-cuenca 

Los afluentes son los ríos secundarios que desaguan en el río principal. Cada 

afluente tiene su respectiva cuenca, denominada sub-cuenca, con una extensión de 

hasta 50000 ha (BLIEMSRIEDER, 2011) 

1.5.1.4. Micro-cuenca 

Según micro-cuenca es la unidad hidrográfica de menor superficie que una sub-

cuenca, cuyos cauces son tributarios de la misma. Su extensión física no va más allá 

de 4000 hectáreas. Para efectos de planificación se puede identificar con la 

dimensión y extensión de los predios. (BLIEMSRIEDER, 2011) 

1.5.1.5. Unidad de Cuenca 

Es la unidad más pequeña de una demarcación hídrica, corresponde a ella los 

pequeños riachuelos que alimentan al micro-cuenca. (BLIEMSRIEDER, 2011) 

1.5.2. Partes que conforman una cuenca. 

 

1.5.2.1.Cuenca de recepción (Cuenca Alta). 

 

Es la zona que tiene la mayor producción de agua, aquí existe gran biodiversidad, 

se da en este lugar el fenómeno de socavación. Comprende alturas superiores a los 

3000 msnm, con precipitaciones de 1000 – 2000 mm/año. (BORJA, 2002) 
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1.5.2.2. Garganta a canal de desagüe (Cuenca Media) 

 

La cuenca media  comprende las zonas de pie de monte y valles bajos, entre los 800  

y 3000 msnm, con precipitaciones de 100 -1000/, año, aquí el río principal mantiene 

su cauce definido, es una zona de escurrimiento, En este espacio se encuentran los 

valles interandinos. (BORJA, 2002). 

 

1.5.2.3. Lecho o cono de deyección (Cuenca Baja) 

 

Lugar donde el material extraído de la parte alta se deposita, con un caudal de flujo 

continuo, cauce definido y amplia planicie de inundación. En esta parte, el uso de 

la tierra es predominantemente agrícola, con mayor densidad poblacional. Va desde 

el nivel del mar hasta los 800 msnm. (BORJA, 2002). 

Gráfico 3: Partes de una cuenca Hidrográfica 

 

 

Fuente: CATIE 2006 

 

1.5.3. Demarcación Hidrográfica 

 

Se entiende por demarcación hidrográfica la zona terrestre y marina, compuesta por 

una o varias cuencas hidrográficas vecinas y las aguas de transición, subterráneas y 

costeras asociadas a dichas cuencas. 

Actualmente la Secretaría Nacional del Agua para la gestión eficiente de los 

recursos hídricos ha dividido al país en nueve Demarcaciones Hidrográficas, con 
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sus respectivos Centros Zonales, de acuerdo a lo que establece el Acuerdo 

Ministerial No. 2010–66, de fecha 20 de enero del 20102, mediante el cual establece 

y delimita las nueve demarcaciones hidrográficas en unidades administrativas 

desconcentradas en lo administrativo y financiero, a través de las cuales se ejercerá 

la planificación y gestión integrada de los recursos hídricos e integral del agua en 

todo el territorio nacional. (GIGNOUX J. , 2003.). 

 

1.5.3.1.Centros zonales 

 

Los centros zonales se encargarán de la gestión integral de los recursos hídricos por 

demarcación hidrográfica, tomando en cuenta la planificación hídrica establecida 

para las cuencas hidrográficas y administrar con eficiencia el recurso hídrico con 

un enfoque de equidad y solidaridad. (GIGNOUX J. , 2003.). 

 

1.5.3.2.Sub Cuenca 

 

Los afluentes son los ríos secundarios que desaguan en el río principal. Cada 

afluente tiene su respectiva cuenca, denominada sub-cuenca, con una extensión de 

hasta 50000 ha (GIGNOUX J. , 2003.) 

 

1.5.3.3.Microcuenca 

 

Micro-cuenca es la unidad hidrográfica de menor superficie que una sub-cuenca, 

cuyos cauces son tributarios de la misma. Su extensión física no va más allá de 4000 

hectáreas. Para efectos de planificación se puede identificar con la dimensión y 

extensión de los predios. (GIGNOUX J. , 2003.) 
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1.5.3.4.Unidad de Cuenca 

 

Es la unidad más pequeña de una demarcación hídrica, corresponde a ella los 

pequeños riachuelos que alimentan la micro cuenca. (GIGNOUX J. , 2003.) 

 

1.5.4. Componentes de una Cuenca Hidrográfica 

1.5.4.1. Componente Biológico 

 

Los bosques, los cultivos y en general los vegetales conforman la flora, 

constituyendo junto con la fauna el componente biológico. La vegetación que cubre 

la cuenca, está compuesta de restos de un bosque secundario, frutales, arbustos, 

pastos naturales, en cuanto a su fauna silvestre, esta ha sido reducida a punto de que 

muchas especies han desaparecido. (POATS, 2006). 

 

1.5.4.2.Componente Físico 

 

El agua, el suelo, el subsuelo, y el aire constituyen el componente físico. La cuenca 

presenta desde su parte más alta hasta su base, un relieve inclinado y cortado por 

quebradas. Los suelos que se encuentran en el área de la cuenca son variados, en la 

parte alta los suelos están relacionados con bosques naturales, estos mantienen 

humedad y tienen una fertilidad natural. (POATS, 2006). 

1.5.4.3.Componente Socio Económico 

 

Son las comunidades que habitan en la cuenca, las que aprovechan y transforman 

los recursos naturales para su beneficio, construyen obras de infraestructura, de 

servicio y de producción, los cuales elevan el nivel de vida de estos habitantes. 

(POATS, 2006) 
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Gráfico 4: Partes de una cuenca Hidrográfica 

 

 

Fuente: Manual de manejo de cuencas WORLD VISION 2003  

 

1.5.5. Uso del agua en la Agricultura. 

 

En agricultura, para el riego de los campos. En ganadería, como parte de la 

alimentación de los animales y en la limpieza de los establos y otras instalaciones 

dedicadas a la cría de ganado, los recursos hídricos han tenido una importancia 

crítica para la sociedad humana desde que las personas descubrieron que podrían 

producir alimentos cultivando las plantas. (BLIEMSRIEDER, 2011) 

 

El área regable neta del Ecuador es de aproximadamente 3’136.000 Has, el 93.3% 

de las cuales están sobre las cuencas de la vertiente del Pacífico y la diferencia sobre 

la vertiente Amazónica. La cuenca más importante en extensión es la del río 

Guayas, que representa el 40.4% de la superficie regable del país, seguida de la del 

río Esmeraldas con el 12.6%. Del total del área regable, apenas 560.000 Has están 

bajo riego, lo que representa el 30% de la superficie cultivada del país. Sin embargo 

la agricultura bajo riego tiene una significación mucho mayor que la de secano, 

aportando aproximadamente con el 75% del valor de la producción agrícola 

nacional. (BLIEMSRIEDER, 2011). 
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1.6. Sistemas de Información Geográfica 

 

Un sistema de información  geográfica (SIG) es una  herramienta de captura,  

almacenamiento y administración  de datos y atributos asociados  espacial y 

geográficamente  referenciados. 

1.6.2. Elementos de los Sistemas de información Geográfica 

 

Un SIG está formado por cinco componentes o elementos y cada uno de esos 

componentes cumplen con una función para que existan entre ellos una interacción. 

Es decir, éstos conforman la información para que sea procesada o se realice un 

tratamiento, los recursos técnicos, humanos y las metodologías que se adopten en 

la organización o la empresa. A continuación se describen a esos componentes:  

1.6.2.1. Hardware  

 

Es el equipo de cómputo con el que opera un SIG. Actualmente el software de estos 

sistemas se ha adaptado a diversos tipos de hardware desde arquitecturas clientes-

servidor hasta computadoras de escritorio aisladas. Para las consultas espaciales el 

hardware es útil para efectuar el procesamiento de las operaciones que con base a 

algoritmos solucionan las relaciones entre geometrías.  

1.6.2.2. Software 

Proporciona las herramientas y funciones necesarias para almacenar, analizar y 

desplegar la información geográfica, para ello se necesitan de elementos principales 

de software los cuales son:  

➢ Herramientas para la entrada y manipulación de información geográfica.  

➢ Un sistema de administración de base de datos (DBMS Data Base 

Management System).  

➢ Herramientas que soportan consultas, análisis y visualización de elementos 

geográficos.  

Una interfaz gráfica de usuario (GUI Graphical User Interface) de manera que 

facilite el acceso a las herramientas anteriormente mencionadas. 3 En éste se 
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implementan aplicaciones como las consultas espaciales, los lenguajes visuales 

para consultas espacio-temporales como lo refiere  (Bonhomme, 1999) y en el caso 

de las consultas espaciales poder utilizar la tercera dimensión de los objetos según 

Grün (Grun, 1999). 

1.6.2.3. Dato 

 

Se refiere al elemento principal para lograr una correcta información. Es decir una 

vez conocido el objeto del modelo del mundo real, se identifican las propiedades 

que lo forman, por ejemplo, sus atributos que se refieren a los elementos 

descriptivos y el tipo de geometría como el elemento espacial. En las consultas 

espaciales es necesario conocer el tipo de geometría entre los objetos del mundo 

real que se relacionan topológicamente. (Bonhomme, 1999) 

1.6.2.4. Gente 

Son las personas que se encargan de administrar el sistema así como de desarrollar 

un proyecto basado en el mundo real, entre los que se involucran analistas, 

desarrolladores, administradores, programadores, y usuarios. Por ejemplo, para las 

consultas espaciales, esas personas se refieren a quienes proporcionan la 

información fuente, realizan la edición de la información, implementan los 

algoritmos útiles para resolver las consultas espaciales y los usuarios finales que se 

favorecen de la aplicación o proyecto elaborado. (Bonhomme, 1999) 

1.6.2.5. Métodos 

 

Son los planes de un buen diseño y las normas por parte de la empresa, las cuales 

son modelos y prácticas de operación de cada organización. (ESRI, 2011)Este 

último se basa en los estándares reconocidos para aspectos geográficos, que 

sugieren las medidas a adoptar para un determinado enfoque de aplicación y de esta 

manera respaldar su forma de trabajo. Por ejemplo en las consultas espaciales en  

(Gis, 2001) refiere los modelos para implementar las relaciones topológicas entre 

objetos del modelo del mundo real basados en un modelo de objetos geométricos. 

Los componentes mencionados tienen la finalidad para establecer la estructura de 

un SIG y en concordancia con ello implementar aplicaciones que apoyen la toma 
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de 4 decisiones como por ejemplo las consultas espaciales, reiterando que esa 

aplicación por sí sola no refleja la solución, sino que es interpretada por la persona 

responsable de decidir. (Gis, 2001) 

 

1.7.Valoración Crítica 

 

La sub cuenca es una responsabilidad compartida, entre todos y cada uno de los 

habitantes del Cantón Latacunga, dentro de la unidad de gestión territorial, en la 

cual interacciona biofísica y socioeconómicamente el ser humano, los recursos 

naturales, los ecosistemas y el ambiente, con el agua como recurso que une e 

integrada sistémicamente la sub cuenca.  

En el caso de las sub cuencas del rio principal de Latacunga es importante el tema 

de la institucionalidad, debido a que lo que hay en la actualidad no es suficiente 

para la gestión del recurso vital agua y en manejo integral de la cuenca, son 

necesarios mecanismos de interacción formal e informal que generen procesos de 

gobernabilidad. Además se debe identificar los procesos políticos del país y la 

dificultad que presentaría los procesos a mediano y largo plazo con continuidad.  

Otros factores a tener en cuenta en la gestión y manejo de estas sub cuencas son 

problemas de seguridad alimentaria por la poca producción de cultivos en la sub 

cuenca, la vulnerabilidad y riesgo por pendientes, la calidad del agua que es 

importante para el proyecto y la existencia de ecosistemas frágiles que van a sufrir 

alteraciones con el proyecto, lo cual incide en el ciclo hidrológico, para esto 

debemos trabajar de manera conjunta con las autoridades delas GADs tanto 

provincial como cantonal, y determinar los objetivos generales para el desarrollo 

del cantón y provincia teniendo en cuenta el plan nacional del buen vivir  
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1.8. Análisis de Tendencias 

 

El manejo integrado de cuencas hidrográficas implica incorporar incrementalmente 

más variables, temas, intereses y actores en los procesos de decisión y conducción 

de las múltiples intervenciones en una cuenca, para poder subsanar los actuales 

problemas de sequía que atraviesa el cantón, y que está afectando principalmente a 

los pequeños productores. 

  

El propósito es minimizar los conflictos causados por las múltiples intervenciones 

actuales y futuras, que se dan por parte de los GAD’s  para conjuntamente alcanzar 

metas de desarrollo sustentable, dentro del Cantón, para esto actualmente se habla 

de la gestión integrada de cuencas. 

 

La intervención de las autoridades con propósitos de manejo de todos los recursos 

naturales (agua, suelos, bosques, fauna, flora, paisaje) así como los construidos, en 

una cuenca lo cual implica manejarlos con fines de protección, recuperación, 

conservación, producción así como buscar proteger las capacidades de las cuencas 

para captar y descargar agua en calidad, cantidad y tiempo de ocurrencia adecuados. 

 

 

Si las autoridades no toman cartas en el asunto en el futuro nos veremos con 

problemas de agua de riego para los pequeños productores lo que ocasionaría una 

grave crisis dentro del sector agropecuario al no tener ningún plan de manejo 

integral de sub cuencas, para poder almacenar agua y entregarla de acuerdo a las 

necesidades de cada agricultor. 

 

La relación entre los programas de gestión integrada de cuencas y los procesos de 

desarrollo sostenible presenta un dilema fundamental: 

¿Deberían los programas de gestión de cuencas hidrográficas incorporar objetivos 

de desarrollo sostenible y, por lo tanto, el compromiso de proporcionar beneficios 

y servicios que no se relacionan directamente con la gestión de los recursos 

naturales?  
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¿Deberían estar incorporados en procesos más amplios de desarrollo sostenible, 

asegurando que el desarrollo sostenible tenga en cuenta las cuestiones de las tierras 

y el agua? 

 

La Gestión Integrada de los Recursos Hídricos (GIRH) es el proceso que tiene como 

objetivo asegurar el desarrollo y manejo coordinado del agua en interacción con 

otros sistemas naturales, sociales y culturales, maximizando el bienestar económico 

sin comprometer a los ecosistemas vitales. Ello implica una mayor coordinación en 

el desarrollo y gestión de: tierras y agua, aguas superficiales y subterráneas, cuencas 

fluviales y entornos costeros y marinos adyacentes, e intereses río arriba y río abajo. 

(Pochat, 2008) 

 

El agua es un recurso estratégico para el desarrollo de las economías regionales. La 

asignación del agua disponible en una región debe atender no sólo los 

requerimientos ambientales y las necesidades básicas del ser humano, sino también 

elevar su calidad de vida, poniendo el recurso hídrico al servicio del desarrollo y 

bienestar de la sociedad. 

 

Un enfoque de GIRH requiere que las políticas y prioridades consideren la 

repercusión sobre los recursos hídricos, incluyendo la relación mutua existente 

entre las políticas macroeconómicas y el desarrollo, gestión y empleo del agua; las 

decisiones relacionadas con el agua, adoptadas a nivel local o en la cuenca 

hidrográfica estén en la línea o, por lo menos, no choquen con la consecución de 

objetivos nacionales más amplios y la planificación y estrategias en el ámbito 

hidrológico se integren en objetivos sociales, económicos y ambientales más 

amplios (Pochat, 2008) 

 

Teniendo en cuenta la importancia de los recursos hídricos, según (GWP, 2005) en 

la práctica, se debe otorgar al agua el lugar que le corresponde en la agenda política 

nacional, crear una mayor “concienciación sobre el agua” entre los responsables de 
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diseñar las políticas en el ámbito de la economía y en los sectores relacionados con 

el agua, poner en pie canales de comunicación más eficaces y un proceso de toma 

de decisiones consensuado entre los organismos gubernamentales, organizaciones, 

grupos de intereses y colectivos civiles y estimular a la población a superar las 

definiciones sectoriales tradicionales. 

 

El desarrollo sustentable no se refiere a una meta tangible ni cuantificable a ser 

alcanzada en determinado plazo y momento. Se refiere más bien a la posibilidad de 

mantener un equilibrio entre factores que implican un cierto nivel de desarrollo del 

ser humano, nivel que es siempre transitorio, en evolución y, al menos en teoría, 

debería ser siempre conducente a mejorar la calidad de vida de los seres humanos. 

El llamado desarrollo sustentable es, en consecuencia, la resultante de un conjunto 

de decisiones y procesos que deben llevar a cabo generaciones de seres humanos, 

dentro de condiciones siempre cambiantes, con información usualmente 

insuficiente, sujetas a incertidumbres y con metas poco compartidas por una 

sociedad y personas en general no muy solidarias. Sólo si el desarrollo sustentable 

se mantiene en el tiempo se alcanza la sostenibilidad. Cabe resaltar que la sociedad 

se ha organizado para conducir procesos de gestión a nivel de territorios delimitados 

para alcanzar sobre todo metas de crecimiento económico y a veces metas sociales 

pero muy escasamente para manejar territorios delimitados por razones naturales, 

como es el caso de la gestión del agua a nivel de cuenca. Esto implica que sólo 

existen algunas bases de gobernabilidad para alcanzar en forma coordinada metas 

económicas, sociales y ambientales en los territorios actualmente delimitados por 

razones político—administrativos (límites distritales, provinciales, estatales, 

regionales o de países), y no para hacerlo a nivel de cuenca u otros territorios 

delimitados por razones naturales (DOUROJEANNI, 2002) 

 

Las actividades productivas pueden tener un impacto importante en el medio 

ambiente y en la salud de la población. Una gestión inadecuada de los recursos 

naturales, principalmente de la tierra y del agua, puede generar un agotamiento de 

los recursos hídricos, contaminar las aguas superficiales y subterráneas, provocar 
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la erosión de los suelos y favorecer procesos de desertificación destruyendo los 

ecosistemas naturales. Por ejemplo, cuando los sistemas de riego no son eficientes, 

parte del agua extraída se pierde y aunque parte de esta agua llega de nuevo a los 

ríos o a los acuíferos 19 subterráneos, las pérdidas excesivas contribuyen a 

intensificar las repercusiones ambientales negativas que tiene el regadío. 

(DOUROJEANNI, 2002) 

 

1.9. Legislación relacionada específicamente con el manejo de cuenca 
 

En la constitución Política del estado Ecuatoriano en sus artículos 224, 228 y223 

determina: que los Consejos Provinciales son la “entidades del poder político que 

ejerce el gobierno, la administración y representación política del Estado en la 

jurisdicción provincial” y que son las entidades encargadas del manejo de cuencas 

en sus respectivas jurisdicciones. 

Entre otras competencias la constitución Política da las siguientes atribuciones: 

Proteger el ambiente, velar porque este derecho no sea afectado y garantizar la 

preservación de la naturaleza en toda su jurisdicción Art. 86 de la constitución. 

Promover y ejecutar las obras de alcance provincial en vialidad, medio ambiente, 

riego y manejo de las cuencas y micro cuencas hidrográficas de la jurisdicción (Art 

233) 

Es responsable de la planificación del desarrollo provincial en coordinación con las 

municipalidades y la ODEPLAN (Art 255) 

Es responsable de llevar a cabo todas las competencias y atribuciones que por 

efectos y con cargo al proceso de Descentralización señala Art. 10 de la Ley de 

descentralización del Estado, más todas aquellas que le gobierno Nacional y la 

entidades dependientes del poder ejecutivo el transfiere (Art. 226). 

Ejercer el desarrollo prioritario, integral y sostenido de las actividades agrícolas, 

pecuarias, acuícola, pesquera y agroindustrial y estimular los proyectos de 

forestación y reforestación de la provincia 
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1.10. Fundamentación de la Investigación 

 

En el estudio y planificación de una cuenca hidrográfica es indispensable la 

comprensión y aplicación del concepto de estabilidad para el buen uso y manejo de 

los recursos naturales. En la actualidad la presión del hombre sobre éstos es tan 

fuerte que su efecto sobre las características del medio pueden, y de hecho hacen, 

que un ecosistema cambie por completo y su respuesta varíe en perjuicio del 

hombre. El sistema cada vez cambia de una órbita superior a una inferior hasta que, 

al final, puede llegar a un punto de equilibrio donde la producción es igual a cero 

pues se ha convertido en una zona desertificada o erosionada a grado máximo. 

Desde el punto de vista antrópico, antes que el sistema llegue a su última órbita, se 

clasifica como inestable (GASPARI, 2006) 

 

La planificación hidrológica en una cuenca hidrográfica es fundamental conocer el 

momento y el lugar donde se desarrollará, por ello se debe caracterizar el suelo, la 

geomorfología, la topografía, el clima, como así también las especies vegetales 

presentes. El estado de desarrollo de la cobertura vegetal y su manejo, ejercen una 

influencia fuerte sobre las características hidrológicas. 

 

El desarrollo de un Plan de Manejo de una Cuenca Hidrográfica (MCH) es definido 

también como Plan de ordenamiento de la cuenca, cuyos objetivos pueden ser: la 

regulación del régimen hidrológico, el control de la erosión, el control de las 

inundaciones y la conservación de los recursos naturales, entre otros. (GASPARI, 

2006) 

 

Una de las funciones de un plan de ordenación y manejo de cuencas hidrográficas 

es promover el desarrollo de programas de investigación aplicada y difusión en el 

ámbito de cuencas hidrográficas y de conservación de suelos y aguas. Además 
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evaluar y monitorear los procesos que inciden en la degradación y funcionamiento 

de cuencas hidrográficas. (VISSCHER, 2004) 

 

Los objetivos para el MCH son establecidos a partir de los propósitos particulares 

de manejo de cada cuenca hidrográfica. En la ilustración N° 4 se expresa una serie 

de propósitos posibles y los tipos de medidas de ordenación agrohidrológica que 

recomienda para su atenuación. (GASPARI, 2006) 

 

La importancia de los recursos hídricos de las cuencas y sub cuencas radica en que 

la disponibilidad de este recurso depende de la planificación de agua tanto para 

consumo humano como para riego. Al realizar estos estudios hidrológicos en las 

diversas fuentes del Ecuador estaríamos contribuyendo al cumplimiento del 

objetivo 4.2 de Plan Nacional para el Buen Vivir. 

 

Los resultados obtenidos de los estudios sobre cuencas y sub cuencas están 

orientados principalmente a obtener conclusiones sobre la disponibilidad del 

recurso hídrico en la sub cuenca del cantón Latacunga. 

 

La gestión de cuencas presenta la necesidad de tener una base de datos que permita 

coordinar y planificar acciones en cada unidad de manejo y gestión (UMG), a fin 

de contribuir a establecer pautas para su ordenación. Para ello un Sistema de 

Información Geográfica (SIG) constituye un instrumento básico para el 

procesamiento de datos geoespaciales y cartográficos, debido a su versatilidad de 

almacenamiento, superposición y asociación de variables físicas, naturales, sociales 

y económicas.  

 

Los Sistemas de Información Geográfica son herramientas informáticas que 

procesan y analizan datos con algún componente espacial. El National Centre of 

Geographic Information and Analysis (NCGIA) expresa que un SIG es un sistema 
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de hardware, software y procedimientos elaborados para facilitar la obtención, 

gestión, manipulación, análisis, modelado, representación y salida de datos 

espacialmente referenciados, para resolver problemas complejos de planificación y 

gestión. (NCGIA, 1990) 

 

1.11. Bases Teóricas.  

 

1.11.1. Teledetección. 

 

La teledetección o percepción remota es una ciencia que  integra un amplio conjunto 

de conocimientos y tecnologías utilizadas para la observación, el análisis, la 

interpretación  de fenómenos terrestres y planetarios. 

Permite adquirir información sobre ciertos objetos  materiales por medio de 

mediciones tomadas a cierta  distancia, sin hacer contacto físico con éstos. 

 

1.11.2. Elementos de la Teledetección 

 

1.11.2.1. La fuente de energía  

Es la que "ilumina" el objetivo emitiendo una onda electromagnética (flujo de 

fotones). También es posible medir el calor que se desprende de la superficie del 

objetivo (infrarrojo térmico). En este caso el propio objetivo es la fuente de energía 

(aunque se trata de energía solar almacenada y reemitida). (CNICE, 2006) 

1.11.2.2. El objetivo o escena  

Es la porción de la superficie terrestre observada por el satélite. Su dimensión varia, 

en función de la resolución del captador, de unos pocos km² a algunos miles de km².  
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1.11.2.3. El captador o sensor  

De teledetección mide la energía solar (es decir la radiación electromagnética) 

reflejada por el objetivo. El captador puede encontrarse en un satélite o en un avión, 

sobrevolando el objetivo a una altura de pocos centenares de metros hasta distancias 

de 36000 kilómetros en el caso de los satélites meteorológicos. 

Los captadores embarcados en los satélites miden la radiación electromagnética 

reflejada y posteriormente reenvían esta información a la Tierra mediante un 

emisor. En la Tierra una red de estaciones de recepción se encarga de recibir y 

almacenar estos datos. 

Cuando la fuente de energía es el Sol, y el captador solo mide la radiación reflejada, 

se conoce como teledetección pasiva. Esta modalidad de teledetección solo es 

operativa durante las horas diurnas. Por la noche o cuando hay nubes que se 

interponen no es posible realizar observaciones. La observación de las regiones 

tropicales no es fácil con esta modalidad de teledetección, a causa de la frecuente 

presencia de densas coberturas de nubes en estas zonas. Asimismo son difíciles de 

observar las regiones polares durante los periodos invernales, debido a la reducida 

iluminación solar que reciben. 

En los casos que el mismo satélite lleva una fuente emisora de energía (radar) que 

envía hacia el objetivo y mide el eco producido se le denomina teledetección activa. 

El radar atraviesa la cobertura de nubes lo que facilita la obtención de imágenes 

independientemente de las condiciones meteorológicas, tanto de día como de 

noche. 

Aunque las imágenes de radar son más difíciles de analizar, complementan los datos 

de la teledetección pasiva y ofrecen información adicional sobre otros aspectos 

como la topografía del terreno. (CNICE, 2006) 
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Gráfico 5: Principios de la Teledetección 

 

Fuente: (CNICE, 2006) 

1.11.3. Geolocalización 

 

La geolocalización es aquel proceso que se encarga de determinar la posición de 

algo en particular en la tierra; en otras palabras, la geolocalización alude al 

posicionamiento referente a la localización de un objeto ya sea animado o 

inanimado, que se presenta por medio de un vector o punto, en un sistema de 

coordenadas y datum determinado. Este proceso se realiza generalmente en los 

sistemas de información geográfica. Entonces podemos decir que la 

geolocalización se encarga específicamente en obtener la localización de una 

persona, empresa, evento, ciudad, pueblo etc. en un punto geográfico exacto que es 

determinado por medio de ciertas coordenadas, usualmente provenientes de 

satélites, pero que cabe destacar que también pueden provenir de otros dispositivos 

como los móviles. (Foursquare, 2006) 

1.12. Campo Legal 

La Constitución de la República aprobada en referéndum del 28 de septiembre de 

2008, publicada en el Registro Oficial No. 449 de 20 de octubre de 2008, en su 

primera disposición transitoria, inciso segundo establece que en el plazo máximo 

de tres cientos sesenta días, entre otras se aprobará la "ley que regule los recursos 

hídricos, usos y aprovechamiento del agua, que incluirá los permisos de uso y 

http://conceptodefinicion.de/tierra/
http://conceptodefinicion.de/objeto/
http://conceptodefinicion.de/ciudad/
http://conceptodefinicion.de/pueblo/
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aprovechamiento, actuales y futuros, sus plazos, condiciones, mecanismos de 

revisión y auditoria, para asegurar la formalización y distribución equitativa de este 

Patrimonio".  (Constitución de la Republica, 2008) 

 

La misma Constitución en el Art. 411 señala que “corresponde al Estado 

ecuatoriano garantizar la conservación, recuperación y manejo integral de los 

recursos hídricos, cuencas hidrográficas y caudales asociados al ciclo hidrológico”; 

y, en el Art. 313 determina que “el agua es un sector estratégico de decisión y 

control exclusivo del Estado, al que corresponde administrar, regular, controlar y 

gestionar, de conformidad con los principios de sostenibilidad ambiental, 

precaución, prevención y eficiencia”.  (Constitución de la Republica, 2008) 

1.13. Medio Ambiental 
 

El agua es parte del ambiente y como tal, no puede ser entendida de otra manera 

que no sea como elemento integrado e integrador del ambiente. 

La muestra de movimiento y recorrido del agua por el planeta lleva a postular la 

idea de que este elemento vital para realizar las interacciones con todos los 

componentes ambientales.  

Sin embargo, es un bien escaso si bien  el 70 % de la superficie del mundo está 

cubierta por agua, solamente el 2.5% es dulce, mientras que el restante 97.5% es 

agua salada (PNUMA, 2000). 

1.14. Hipótesis y Determinación de las Variables  
 

Para el desarrollo de la investigación se establece la siguiente hipótesis: 

La falta de georreferenciación de los cauces del cantón Latacunga, conlleva al 

desconocimiento total de agua presente en la sub cuenca lo que conlleva a la falta 

de gestión de los GAD´s 

Y se determina las siguientes variables: 

Variable independiente.- Características de la sub cuenca. 

 Variable dependiente.- Volumen de Agua. 
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Tabla 2: Operacionalización de las Variables 

 

Elaborado: David Carrera 

 

 

 

 

 

 

 

 

 

VARIABLES 

 

DIMENSIONES 

 

INDICADORES 

 

ÍNDICE 

 

TÉCNICAS 

 

INSTRUMENTOS 

Características 

de  la sub 

cuenca 

Localización Ubicación política 

Geolocalización 

 

GMT 

Observación 

Medición 

Registro 

Mapas 

 Caracterización Superficie de la 

subcuenca 

Longitud de ríos 

 

Km2 

 

m 

 

Medición Registro 

Mapas 

 Componentes de 

la cuenca 

Ríos 

Arroyos 

Tipo de cuenta 

# 

# 

Clase: 

Alta, 

Media, 

Baja 

Medición 

 

 

Observación 

Registro 

Mapas 

 

 

 

Volumen de 

agua 

Ríos 

Riachuelos 

 

Volumen m3 Medición Registro 
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CAPÍTULO II 

2. Métodos, procedimientos y técnicas de Investigación  

 

El método de investigación que sustenta esta investigación es el método hipotético-

deductivo el cual según varios epistemólogos, es el procedimiento o camino que 

sigue el investigador para hacer de su actividad una práctica científica. Las 

características de esta investigación permitieron la realización de los cálculos 

necesarios para determinar la cantidad de agua presente en la sub cuenca del Rio 

Cutuchi y medir la longitud de los cauces principales que forman dicha sub cuenca  

 

2.1. Tipo de Investigación  

 

El presente trabajo de investigación realizará “una investigación que mediante los 

procesos cuantitativo; se analizara profundamente una unidad de la sub cuenca para 

responder al planteamiento del problema,” (Hérnandez, 2006) “las investigaciones 

descriptivas utilizan criterios sistemáticos que permiten poner de manifiesto la 

estructura o el comportamiento de los fenómenos en estudio, proporcionando de ese 

modo información sistemática y comparable con la de otras fuentes”, con esto 

determinamos que nuestra investigación es descriptiva porque nos ayuda a 

determinar las sub cuenca alta media y baja del cantón Latacunga así como también 

los cauces que forman cada una de las sub cuencas. 

 

Además de la investigación es exploratoria,  se realiza cuando el objetivo consiste 

en examinar un tema poco estudiado (Hérnandez, 2006), como es el estudio de las 

cuencas y sub cuencas mediante la utilización de los sistemas de información 

geográficos, temática que no ha sido tratada con la suficiente seriedad del caso que 

es el agua para la producción agropecuaria. 
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2.2. Técnicas e instrumentos para la recolección de datos.  

 

Las técnicas que se consideran más adecuadas para el desarrollo de la presente 

investigación es:  

 

2.2.1. Observación  

 

Para (Herrera, 2004) Existen cinco tipos de observación: Directa cuando el investigador 

se pone en contacto cercano, Participante cuando el investigador comparte la vida en 

grupo estudiado y Estructurada cuando es planificada en todos los aspectos, métodos y 

es críticamente realizada y se registran con instrumentos técnicos especiales. Bajo esta 

concepción nuestra investigación toma en cuenta la Observación estructurada pues 

utilizaremos instrumentos técnicos especiales, así como software especializados para 

el caso en la delimitación del sub cuenca principal. 

 

3. Metodología 

 

La metodología que se aplicó  para la identificación de las sub cuenca fue la de 

Pfafstetter que consiste en asignar identificadores (ID) a unidades de drenaje basado 

en la topología de la superficie o área del terreno; asigna Ids a una unidad 

hidrográfica para relacionarla con las unidades hidrográficas que contiene y de las 

unidades hidrográficas con las que limita. 

3.1. Metodología de Pfafstetter 

 

La metodología de Pfafstetter consiste en asignar Identificadores (Ids) a unidades 

de drenaje basado en la topología de la superficie o área del terreno; dicho de otro 

modo asigna identificadores a una unidad hidrográfica para relacionarla con sus 

unidades internas locales y con las unidades colindantes. (Rojas, 2008) 
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3.1.2. Características Principales 

 

➢ El sistema es jerárquico y las unidades son delimitadas desde las uniones de 

los ríos (punto de confluencia de ríos) o desde el punto de desembocadura 

de un sistema de drenaje en el océano. 

➢ A cada unidad hidrográfica se le asigna un específico código Pfafstetter, 

basado en su ubicación dentro del sistema de drenaje que ocupa, de tal forma 

que éste es único al interior Este método hace un uso mínimo de dígitos en 

los códigos, tal es así, que el número de dígitos representa el nivel en el que 

se encuentra la unidad. 

La distinción entre río principal y río tributario, es en función del área drenada. Así, 

en cualquier confluencia, para esta metodología el río principal será siempre aquel 

que posee mayor área de drenaje. . (Rojas, 2008) 

 

3.1.3. Proceso de codificación 

 

En principio se debe determinar el curso del río principal el cual consiste en seguir 

el curso del río desde un punto de confluencia, que en el nivel 1 generalmente es la 

desembocadura de río al mar, hacia aguas arriba hasta identificar una nueva 

confluencia, lugar en el cual se debe realizar la comparación de áreas y continuar el 

trazado del curso por la unidad que tiene mayor área y así sucesivamente hasta 

llegar a la parte superior de la unidad que se está delimitando. Se debe advertir que 

en la metodología de Pfafstetter el único criterio que se utiliza para determinar el 

curso del río principal es el del área de drenaje que contiene el curso a diferencia de 

otras metodologías de carácter hidrológico que toman en consideración el aporte 

del flujo y la longitud del cauce para determinar el río principal. Una vez 

determinado el curso del río principal, se identifican las cuatro áreas mayores de 

drenaje que confluyen al mismo, siempre en función del área que poseen. . (Rojas, 

2008) 
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3.1.4. Procedimiento Específico 

 

Se refiere al procedimiento técnico u operativo que se adopta para el proceso de la 

delimitación y codificación. Esta metodología estará de acuerdo a la herramienta 

SIG que se utiliza, y en función de la experiencia y de las capacidades técnicas y de 

análisis espacial del usuario. 

En el presente trabajo se ha diseñado un procedimiento basado en la metodología 

Pfafstetter, tanto para el proceso de delimitación como para el proceso de 

codificación de unidades hidrográficas. . (Rojas, 2008) 

 

3.2. MÉTODO SEMIAUTOMÁTICO PARA DELIMITACIÓN DE 

CUENCAS.  

 

3.2.1 Conceptos  

 

Con la finalidad de que el método resulte mejor explicado más adelante se presentan 

aquí algunas definiciones de términos: Modelo Digital del Terreno Un Modelo 

Digital del Terreno (MDT), es una estructura numérica de datos que representa la 

distribución espacial de una variable cuantitativa y continua, como puede ser la 

temperatura, la altitud o la presión atmosférica. En el caso que la variable a 

representar es la cota o altura del terreno se denomina Modelo Digital de Elevación. 

(MDE)  

 

Modelo Digital de Elevación El Modelo Digital de Elevación (MDE) es un Modelo 

Digital del Terreno cuyos datos almacenados representan valores de altitud. En la 

actualidad es posible caracterizar la superficie y sobre todo, delimitar cuencas 

hidrográficas a partir de Modelos Digitales de Elevación (MDE). . (Rojas, 2008) 

Estos modelos son simbólicos ya que establecen relaciones de correspondencia con 

el objeto real, mediante algoritmos matemáticos que son tratados mediante 

programas de Sistemas de Información Geográfica (Software SIG). Son estructuras 
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de datos, no son sólo acumulaciones de cifras, sino que tienen una estructura interna 

con la cual deben interpretarse dichos datos. (Rojas, 2008) 

 

3.2.2. Unidad de Análisis 

 

Un punto encajado en el marco metodológico del proyecto de investigación, es la 

delimitación de la población. Según (Chávez, 2007), “La población es el universo 

de la investigación sobre la cual se pretende generalizar los resultados. Está 

constituida por características o estratos que permiten distinguir los sujetos unos de 

otros”. De acuerdo con los propósitos de la investigación, se aplicó el método no 

probabilístico, ya que este muestreo desconoce la probabilidad que tienen los 

elementos de la población para integrar la muestra. 

Para la presente investigación, la unidad de análisis a estudiar la sub cuenca 

principal del cantón Latacunga y sus cauces que lo componen. 

 

3.3. Técnicas de Recolección de Datos 

 

Para la elaboración de la presente investigación utiliza las técnicas de la encuesta, 

observación  y revisión documental. 

 

3.3.1. Revisión Documental.- Para recolectar la información se utiliza la técnica 

de revisión documental de la información existente principalmente en el 

internet y en artículos científicos sobre la temática en estudio. 

 

3.2.2. Bibliografía, Internet y otras fuentes.- También se utilizó este 

instrumento en la obtención de la información, apoyándonos en 

documentación técnica del fabricante, registros, formatos, normas, 

publicaciones de la organización y de los entes reguladores, internet y otras 
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fuentes, así establecer los fundamentos teóricos prácticos que sirvieron de 

soporte para el proyecto de investigación y desarrollo. 
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CAPÍTULO III 

3. Resultados de la Investigación 

 

En este apartado se muestran los resultados alcanzados del análisis de la sub cuenca 

principal del cantón Latacunga 

 

3.1.Características de la sub cuenca (Variable Independiente) 

 

3.1.1. Localización de  los componentes de la Sub Cuenca 

 

En la evaluación de la situación actual, se aplicó teledetección por medio de 

modelos digitales de terreno para determinar la longitud del rio principal. A 

continuación se muestran los resultados alcanzados a través de la aplicación de 

teledetección en la recolección de datos en donde se obtuvo los siguientes 

resultados: 

              Tabla 3: Distribución de las Sub Cuencas  

CUADRO DE DISTRIBUCION DE LAS  SUB CUENCAS  

NIVEL 

SUPERFICIE 

(ha) 

PORCENTAJE 

(%) 

CUENCA BAJA 95332,9 68,8 

CUENCA 

MEDIA 42051,22 30,4 

CUENCA ALTA 1105,87 0,8 

TOTAL 138489,99 100                

                                                       Elaborado: David Carrera 2015 
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Gráfico 6: Distribución de las cuencas 

 

Elaborado: David Carrera 2015 

 

De acuerdo al análisis del cuadro de distribución de la cuencas tenemos 

principalmente que reconocer  la superficie que ocupa la cuenca baja con un 68,8% 

del total del cantón Latacunga y otro indicador importante es la cuenca alta que es 

donde se produce la mayor cantidad de agua necesaria para el consumo humano, 

agrícola entre otros únicamente con un 0,8% del total, lo que nos indica la 

importancia de cuidar el recurso vital. 

Tabla 4: Cuadro de Drenajes 

CUADRO DE DRENAJES 

CAUCE 
LONGUITUD 

(m) 
PORCENTAJE 

ARROYOS 192322,8 57,1 

QUEBRADAS 86411,42 25,7 

RIOS 

SECUNDARIOS 
42416,69 12,6 

RIOS 

PRINCIPAL 
15536,51 4,6 

TOTAL 336687,42 100 
 

                                                                                                                                         Elaborado: David Carrera 2015 
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Gráfico 7: Longitud de los Ríos 

 

Elaborado: David Carrera 2015 

 

De acuerdo con el cuadro se considera la relación que existe entre las distribución 

de la cuencas y la longitud de cada cauce natural que forman la sub cuenca el rio 

principal tiene una longitud de 15536,51 metros que cruza la ciudad de  Latacunga 

y de donde se obtiene el caudal necesario para la producción del agua, 

complementando con las precipitaciones. 

Tabla 5: Manejo de la Sub Cuenca 

MANEJO DE LA SUB CUENCA 

  CUENCA MANEJO  UNIDADES 

SUPERFICIE 138493,21 106282,67 ha 

PORCENTAJE 100 77 % 
 

              Elaborado: David Carrera 2015 

Gráfico 8: Manejo de las Sub cuenca 

 

              Elaborado: David Carrera 2015 

0 50000 100000 150000 200000 250000

ARROYOS

QUEBRADAS

RIOS SECUNDARIOS

RIOS PRINCIPAL

LONGITUD

LONGUITUD

138493,21

106282,67

MANEJO DE LA SUB CUENCA



 

44 

Dentro del manejo de la cuenca como lo muestra en el cuadro podemos conseguir 

una superficie de manejo de 106282,67 hectáreas que lo podemos definir con un 

77% del total de la cuenca, lo que quiere decir que prácticamente existe agua para 

el riego agrícola. 

 

3.1.2. Características físicas de la cuenca. 

 

Las características de la cuenca son los aspectos físicos más importantes en el 

escurrimiento superficial de las cuencas (Linsley, 1977). Con el fin de definir estas 

características se empleó un sistema de información geográfico. 

 

Los datos físicos o morfométricos más comunes y que hemos considerado de mayor 

interés para caracterizar a la sub cuenca de nuestro estudio son los siguientes: 

 

Superficie (Km2 o Ha) 

Perímetro (Km) 

Forma 

Pendiente (%) 

Densidad de Drenaje (Km/Km2) 

 

3.1.2.1. Área 

El área de una cuenca es el parámetro más importante. El área es la proyección de 

la cuenca en el plano horizontal. La superficie para el actual estudio es de 1062,83 

Km2. 
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3.1.2.2.Perímetro 

 

Es la longitud de la divisoria de la sub cuenca. Su longitud está en función de la 

superficie y la forma de la cuenca. El perímetro de la cuenca del rio Cutuchi 

encontrada es de 197,04 Km. 

 

3.1.2.3.Forma 

 

La forma de la cuenca es la configuración geométrica tal como está proyectada 

sobre el plano horizontal de la cuenca tiene una relación directa con el tiempo de 

respuesta recorrido de las aguas a través de la red de drenaje (Manual de hidrología 

1972). Si hipotéticamente se mantiene constantes, a excepción de la forma de los 

demás elementos de una sub cuenca que influyen en la escorrentía, se evidenciara 

la participación directa que la forma de la sub cuenca tiene en el hidiograma de 

salida de escurrimiento resultante. La forma de la cuenca se representa con varios 

índices; los más comunes son: 

• Coeficiente de compacidad o de Gravelius 

• Factor de forma 

 

3.1.2.4.Coeficiente de compacidad 

 

Mientras las sub cuenca se aproximen más a la forma circular el escurrimiento en 

ellas será más uniforme y el caudal pico se orientara a un valor mayor; toda vez 

que, la concentración de escurrimiento hacia los cauces del sistema fluvial tendería 

a ser regulado, ordenado. 

La simetría respecto del centro de la forma circular en el fenómeno del 

escurrimiento significa un tiempo de concentración de esos flujos de agua 

(Naghettini, 2007). 



 

46 

Las cuencas pueden ser evaluadas en términos de las condiciones anotadas, 

valorando la concentración de os flujos influida por las formas de las cuencas. Esa 

valoración de la el coeficiente K de compacidad de Gravelius, con la expresión: 

 

Kc 

En donde: 

Kc: Coeficiente de compacidad, adimensional 

P: Perímetro de la sub cuenca, en Km. 

A: Área de la sub cuenca, en Km2 

 

Matemáticamente el coeficiente de compacidad es la relación entre el perímetro de 

la sub cuenca y la longitud del mismo. El coeficiente de compacidad encontrado 

para nuestra área de estudio es de 1,69. 

 

3.1.2.5.Pendiente 

 

Consiste en relacionar la diferencia de nivel existente entre dos extremos de la 

cuenca con el perímetro de la misma  

Im= Hmax-Hmin/500*P 

En donde: 

Im: Pendiente media de la sub cuenca en % 

Hmax: Altura máxima (msnm) 

Hmin: Altura mínima (msnm) 

P: Perímetro en Km 

La pendiente calculada para la sub cuenca es del 3,13% 
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3.1.2.6. Densidad de Drenaje 

 

Esla relación que existe entre la longitud total de los cursos de agua existentes 

dentro de la sub cuenca y el área de la misma, considerando solo las corrientes 

intermitentes y perennes. 

Dd= Lr/A 

En done: 

Dd: Densidad de drenaje, en Km/Km2 

Lr: Longitud total de los cursos de agua, en Km 

A: Área de la sub cuenca 

Las cuencas y sub cuencas con densidad de drenaje superiores a 3 se definen como 

cuencas bien drenadas o de respuesta hidrológica rápida. La sub cuenca del Rio 

Cutuchi tiene como densidad de drenaje de 0,3, por lo que se puede definir a la sub 

cuenca, como mediamente drenada. Así mismo, según el cuadro siguiente, se puede 

clasificar geológicamente y climáticamente a la sub cuenca, para el resultado 

obtenido en el estudio la sub cuenca geológicamente es arenisca duras, con un clima 

semihúmedo - Húmedo  

Tabla 6: Clasificación Geológica y Climática de la cuenca 

CLASIFICACIÓN GEOLÓGICA Y CLIMATICA DE 

UNA CUENCA SEGÚN DENSIDAD DE DRENAJE 

DENSIDAD 

DE 

DRENAJE 

GEOLOGÍA CLIMA 

0        5 ARENISCAS DURAS 
SEMIHÚMEDO 

HÚMEDO 

5       10 

ROCAS DE DUREZA 

MEDIA Y ZONAS DE 

BOSQUE 

HÚMEDO 

10     25 

ROCAS IGNEAS Y 

METAMORFICAS 

MUY METEORIZAR 

SECO CÁLIDO 

25     50 
SEDIMIENTARIAS 

BLANDAS 
SECO CÁLIDO 

50     100 ROCA SECO CÁLIDO 
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Tabla 7: BALANCE HÍDRICO 

CUADRO DE BALANCE HIDRICO 

MES PRECIPITACION TEMP i ETP`(THORNTHWAITE) SALDO BALANCE CAUDAL 
CAUDAL 

TRASFORMADO 

ENERO 62,79 9,1 2,48 48,89 13,8966215 13,8966215 975,670198 9,756701977 

FEBRERO 83,56 8,9 2,39 47,87 35,6874013 49,5840228 1138,46932 11,3846932 

MARZO 100,83 9,0 2,43 48,38 52,4468679 102,030891 1260,02933 12,60029326 

ABRIL 103,72 9,1 2,48 48,89 54,8266215 156,857512 1279,40467 12,79404674 

MAYO 74,54 8,9 2,39 47,87 26,6674013 183,524913 1070,36635 10,70366353 

JUNIO 44,41 8,4 2,19 45,32 -0,90550638 182,619407 809,248301 8,092483008 

JULIO 30,16 8,1 2,08 43,78 -13,6175779 169,001829 656,651742 6,56651742 

AGOSTO 31,07 8,1 2,08 43,78 -12,7075779 156,294251 667,277461 6,672774605 

SEPTIEMBRE 54,32 8,5 2,23 45,83 8,49247309 164,786724 902,236619 9,022366189 

OCTUBRE 79,99 9,0 2,43 48,38 31,6068679 196,393592 1111,94026 11,1194026 

NOVIMEBRE 78,18 9,0 2,43 48,38 29,7968679 226,19046 1098,28193 10,9828193 

DICIEMBRE 79,96 9,0 2,43 48,38 31,5768679 257,767328 1111,71504 11,11715044 

TOTAL 823,53   28,06 565,76 257,767328   1006,77427 10,06774269 

MEDIA 68,6275 8,75833333             
Elaborado: David Carrera 2015 

a: 0,95 
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Gráfico 9: Balance hídrico y precipitación 

 

 

 

Elaborado: David Carrera 2015 

 

Tabla 8: Volumen de la Sub Cuenca (Variable Dependiente) 

CUADRO DE INUNDACIÓN Unidades 

AREA 2D 1411,78 ha 

AREA 3D 24923,23 ha 

VOLUMEN 10361735831,97 m3 

PP TOTAL 138493,21 mm 

PP MENSUAL 11541,10 mm 

Altura 50 m 

Efectividad 0,59 % 

Efectividad Neta 0,19 % 
 

                                                                                                                                                                                                                                                                                                                                                              Elaborado: David Carrera 2015 

 

Es la efectividad de la represa en llenar  es de 0,19 % de posibilidades por lo que se 

debería bajar la altura para la construcción de la represa primero a 25 m y luego a 10 

m según las necesidades, lo ideal sería llegar a una eficiencia neta del 80% 
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PROPUESTA DE LA INVESTIGACIÓN 

 

4. GEOLOCALIZACION DE LOS RECURSOS HIDRICOS 

 

4.1.JUSTIFICACIÓN 

 

La propuesta adecuada para mejorar la gestión del recurso hídrico se basa en la 

incorporación de los interesados en el proceso de decisión y planeamiento. Por lo tanto, 

la preparación de planes de gestión del recurso hídrico puede ser un proceso más 

participativo que el convencional. 

Una estrategia de manejo del recurso hídrico es usualmente un paso adelante en el 

camino hacia el desarrollo de un plan, debido a que las metas y objetivos básicos deben 

ser establecidos y la dirección clave de los cambios debe ser acordada antes de iniciar 

el planeamiento detallado. Los materiales están relacionados particularmente con las 

iniciativas que están siendo desarrolladas por la Global Water Partnership (GWP) y 

varios países y pueden ser empleados en conjunción con la publicación Catalyzing 

Change (GWP, 2005)la cual aporta elementos adicionales a la discusión. Nosotros 

creemos firmemente que el planeamiento no es un ejercicio lineal, sino que es cíclico 

y debe estar acompañado por evaluación regular, evaluación del progreso del cantón y 

de la provincia. (GWP, 2005) 

 

El recurso hídrico se encuentra bajo presión creciente debido al aumento poblacional, 

la actividad económica y el aumento de la competencia entre los usuarios;  

Las tomas de agua han aumentado dos veces más rápido que el crecimiento de la 

población y actualmente un tercio de la población mundial vive en países que 

experimentan estrés hídrico entre medio y alto 
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Las preocupaciones actuales con respecto a la variabilidad y el cambio climático 

requieren una gestión del recurso hídrico optimizada para enfrentarse con inundaciones 

y sequías más intensas. 

 

4.2. OBJETIVOS 

 

Diseñar una propuesta de manejo integral de los recursos hídrico de la sub cuenca del 

rio Cutuchi 

Obtener el desarrollo sustentable de los recursos hídricos, para las futuras generaciones. 

4.3.ESTRUCTURA DE LA PROPUESTA 

 

➢ Generalidades 

➢ Marco Institucional 

➢ Política de recursos hídricos 

➢ Gestión Nacional 

➢ Propuesta previa del organismo de la cuenca 

➢ Análisis de información geográfica 

 

4.4.DESARROLLO 
 

4.4.1. INSTITUCIONAL 

 

Por varias razones, los gobiernos de los países en desarrollo consideran el planeamiento 

y gestión del recurso hídrico como una parte central de las responsabilidades 

gubernamentales. Este punto de vista es consistente con el consenso internacional que 

promueve el concepto del gobierno como facilitador y regulador, más que como 

implementador de proyectos. El reto es lograr un acuerdo mutuo sobre el nivel en el 

cual, en algún caso específico, la responsabilidad del gobierno debe ceder o ser 
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compartida con entidades autónomas de gestión de los servicios de agua y/o por 

organizaciones comunales. 

 

Con el fin de poner en marcha la GIRH, se deben efectuar modificaciones 

institucionales para permitir: 

El funcionamiento de un consorcio de interesados involucrados en la toma de 

decisiones, con la representación de todos los sectores de la sociedad y con buen 

balance de género;  

➢ Gestión del recurso hídrico basada en límites hidrológicos;  

➢ Estructuras organizacionales a niveles de cuenca y sub-cuenca, para permitir la 

toma de decisiones en el nivel más bajo posible;  

La coordinación del gobierno de la gestión nacional del recurso hídrico entre los 

diferentes sectores de uso de este recurso. (GWP, 2005) 

 

4.4.2. POLÍTICA DE RECURSOS HÍDRICOS  

 

La política de recursos Hídricos es establecida por legislación e implementada por 

instituciones e instrumentos previstos en dicha ley y su reglamentación. Los aspectos 

institucionales dependen de: 

➢ La legislación y reglamentos;  

➢ Las instituciones que manejan los recursos hídricos de acuerdo con los 

instrumentos previstos en la legislación;  

➢ Los mecanismos económicos de sustentabilidad: recuperación de costos y 

financiamiento.  

En general, la política de los recursos hídricos es establecida por legislaciones, 

desagregada en contenidos específicos (sectoriales) o por una legislación integradora. 

La tradición en diversos países durante el siglo veinte siempre fue regular de forma 
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sectorial sin integración. Con el desarrollo de la Gestión Integrada de los Recursos 

Hídricos (GIRH) en la década de los 90, se dio inicio a la implementación del proceso 

de integración intersectorial. GIRH es un nuevo instrumento de gestión desarrollado 

internacionalmente e integra la política de las Naciones Unidas como instrumento para 

cumplir las metas del milenio de reducción de la pobreza, saneamiento, vulnerabilidad 

de población a las enfermedades y desastres naturales.. 

La política actual en Ecuador en el tema de agua es diseminada o sectorizada. 

Solamente, en el mes de agosto de 2009 el Presidente de la República envió a la 

Asamblea una propuesta de Ley Orgánica de Recursos Hídricos, uso y 

aprovechamiento del agua para debate buscando establecer esta política integradora. 

4.4.3. POLÍTICA ACTUAL MARCO LEGAL  

 

El marco legal actual para la gestión del agua es la Ley de Aguas de 1972, que ha sido 

actualizada mediante una codificación realizada en el año 2004 y 2008. La ley establece 

como principios relevantes los siguientes:  

➢ El agua es un bien público;  

➢ El estado concede el derecho de uso del agua con base en criterios definidos;  

➢ En caso de ocurrir la falta de disponibilidad del agua, el uso humano y animal 

es prioritario 

4.4.4. LA LEY DE AGUAS ABORDA LOS SIGUIENTES ASPECTOS:  

 

➢ Conservación y contaminación de las aguas;  

➢ Adquisición de derechos de aprovechamiento de los usos de aguas y prelación; 

➢ Concesiones del derecho de aprovechamiento de aguas para uso doméstico y 

de saneamiento;  

➢ Concesiones del derecho de aprovechamiento para riego;  

➢ Aguas para fines energéticos, industriales y mineros;  

➢ Concesión de derechos de aprovechamiento de aguas subterráneas;  

➢ Aguas minerales, termales y medicinales;  
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➢ Concesión de los derechos de aprovechamiento de aguas remanentes;  

➢ Riego y saneamiento del suelo;  

➢ Estudios y obras;  

➢ Servidumbres;  

➢ Aprovechamientos comunes, de los directorios de aguas y de las juntas 

administradoras de agua potable; 

➢ Infracciones y penas;  

➢ Jurisdicción y procedimiento. 

 

4.4.5. GESTIÓN NACIONAL  

 

En el proceso de descentralización existente en la gestión nacional de agua y ambiente 

se observa que hay muchas entidades que actúan sobre el mismo contenido y dificulta 

el desarrollo de las actividades, aún más si no hay un proceso integrador. La gestión 

del agua fue en un inicio atribución del INERHI - Instituto Ecuatoriano de Recursos 

Hídricos, posteriormente reemplazado por el CNRH - Conejo Nacional de Recursos 

Hídricos y las CRDs Corporaciones Regionales de Desarrollo. En 2008 el CNRH fue 

reemplazado por la SENAGUA - Secretaria Nacional de Recursos Hídricos. Esta 

secretaría tiene la finalidad de conducir y regir los procesos de gestión del agua de una 

manera integrada y sustentable en las cuencas hidrográficas. Se prevé que la gestión 

del agua se la hará de manera desconcentrada, por cuenca hidrográfica o demarcación 

hídrica, a través de organismos de gestión de agua acreditados por la SENAGUA. Real 

López (2007) cita que la Ley de Aguas, la Ley Forestal y de Conservación de Áreas 

Naturales y Vida Silvestre y las leyes de Creación del INAMHI, INERHI e INEFAN 

estableció que las tres entidades citadas, deben tener coordinación interinstitucional 

para proteger y desarrollar las citadas cuencas. Sin embargo, las disposiciones sobre 

cuencas hidrográficas que se incorporaron en las citadas leyes, no tuvieron un efecto 

significativo en la gestión institucional de los entes en referencia. Carente el estado de 

una visión de conjunto sobre los recursos naturales de relevancia hídrica, las políticas 
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en relación a las cuencas hidrográficas en el Ecuador fue visto como espontáneo y 

vinculado al “uso de un determinado recurso o área y no por una planificación ordenada 

del desarrollo" 

 

En 1982, como una estrategia para integrar a las instituciones cuya acción institucional 

confluye en las cuencas hidrográficas, se creó la Comisión Nacional Permanente para 

la Protección y Manejo de las Cuencas Hidrográficas, CONAPCHID, como un cuerpo 

administrativo coordinador y asesor de los diferentes organismos del Estado para 

mejorar la gestión. Sin embargo, esta experiencia de coordinación fracasó debido a 

limitaciones institucionales del estado, por lo que no se concedió a la CONAPCHID 

un estatus definido, y desapareció después de creado el CNRH. Los principales 

problemas institucionales están relacionados con la fragmentación de las atribuciones 

institucionales en recursos hídricos y medio ambiente, sin una  integración en la cuenca 

hidrográfica. El proceso acaba funcionando como sectorial sin integración de los 

objetivos principales de la sociedad que son la calidad de vida y conservación 

ambiental. 

 

 

4.4.6. PROPUESTA PREVIA DEL ORGANISMO DE CUENCA  

 

De acuerdo con Real López (2007). El autor basó su análisis en dos tipos de organismo 

de gestión: uno de derecho público, el segundo de derecho privado. Ambas formas de 

estructurar a un ente de gestión de cuencas tienen sus ventajas y desventajas. En la 

legislación existente y propuesta de financiamiento para el manejo de los recursos 

hídricos es a través de la aplicación de tarifas para la recuperación de costos de las 

inversiones que se realicen y los servicios que se presten. En un esquema de GIRH, las 

tarifas que se fijen a los usuarios, deben reflejar los costos asociados del manejo de 

estos recursos, para lo cual las normas citadas dan un sustento legal. Las alternativas 

para la creación del organismo de cuenca presentada fueron:  
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➢ Un instrumento dictado por los poderes ejecutivo o legislativo (decreto 

ejecutivo o decreto legislativo), los que generalmente se basan en una propuesta 

originada en el grupo social interesado;  

➢ Convenio interinstitucional entre los entes públicos, gobiernos seccionales y 

entidades civiles que se encuentran involucrados en la gestión de los recursos 

hídricos y en la cuenca;  

➢ La creación de un organismo civil con la participación de entidades públicas, 

privadas, civiles, comunitarias entre otros, con intereses en el área.  

 

4.4.7. BENEFICIOS DE LA GIRH 

 

4.4.7.1.Beneficios para la agricultura  

 

La pobre imagen del sector agrícola está relacionada con su papel como el mayor 

usuario de agua y el principal generador de fuentes difusas de contaminación de 

recursos de agua superficial y subterránea. Si se toma esto en conjunto con el reducido 

valor agregado de la producción agrícola, el significado común de lo anterior es que el 

agua es desviada de las actividades agrícolas hacia los otros usos del agua 

(especialmente en situaciones de escasez de agua). Sin embargo, la reducción 

indiscriminada en la asignación de agua para agricultura, tiene consecuencias de largo 

alcance, tanto sociales como económicas. A través de la GIRH, se impulsara a los 

planificadores a ver más allá de la economía del sector y a tomar en cuenta las 

implicaciones de las decisiones de gestión del agua en el empleo, el medio ambiente y 

la igualdad social.  

Al reunir a todos los sectores y a todos los interesados en el proceso de toma de 

decisiones, la GIRH es capaz de reflejar el “valor” combinado del agua y tomar a la 

sociedad como un todo, en la toma de decisiones difíciles que se relacionan con la 

distribución del agua. Esto puede significar que la contribución de la producción de 

alimentos, en la salud, la reducción de la pobreza y en la igualdad de género, por 
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ejemplo, puede hacer pasar por alto las comparaciones económicas estrictas de las tasas 

de rentabilidad de cada metro cúbico de agua.  

La GIRH hace un llamado al planeamiento y planificación integrado, de forma que el 

agua, la tierra y los otros recursos sean utilizados de manera sostenible. Para el sector 

agrícola, la GIRH busca aumentar la productividad hídrica (es decir, más cultivo por 

gota) dentro de las limitaciones impuestas por el contexto económico, social y 

ecológico de una región o país en particular. (BURNEO, 2008) 

 

4.4.7.2.OBJETIVOS  

 

➢ Facilitar la coordinación, con carácter obligatorio, la acción de las entidades 

públicas y privadas para:  

➢ Vigilar que las actividades de las entidades públicas y privadas en las cuencas 

hidrográficas se ejecuten conforme a las disposiciones legales, políticas y 

planes nacionales dictados al efecto;  

➢ Elaborar un Plan de Manejo de la cuenca en el que se determinen los aspectos 

ecológicos, sociales, económicos y de vulnerabilidad social y ambiental, que 

requieran ser tratados, señalando la prioridad para cada caso.  

➢ Precautelar la calidad del agua y los caudales ambientales en las cuencas y 

microcuencas;  

➢ Cooperar y concertar interinstitucional e intersectorialmente, las actividades 

tendientes al manejo sustentable de las cuencas. 

4.4.7.3. FUNCIONES:  

 

• Apoyar a las organizaciones públicas participantes en el cumplimiento de sus 

atribuciones legales, vigilando que no se produzcan duplicación de actividades;  
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• Llevar un registro de las actividades, proyectos, obras y otras intervenciones, que 

pudieran tener impactos negativos en los recursos hídricos (agua, aire, suelo, bosques, 

cuencas) y monitorear su desenvolvimiento;  

• Informar a las entidades públicas correspondientes, cuando alguna de esas actividades 

han incurrido en alguna infracción;  

• Realizar acciones civiles, penales o administrativas, en defensa del ambiente y 

recursos naturales del área;  

• Coordinar y, de ser el caso, apoyar los esfuerzos que realizan las diversas instituciones 

del Estado, tanto centralizadas como descentralizadas, así como las empresas privadas 

en materia de manejo sustentable de cuencas hidrográficas;  

 Controlar que las entidades nacionales y seccionales relacionadas al manejo 

sustentable de los recursos bosque, agua, suelo y biodiversidad, cumplan con las 

disposiciones legales y administrativas relativas al manejo sustentable de cuencas 

hidrográficas;  

➢ Prevenir o manejar conflictos socio ambiental;  

➢ Promover proyectos que faciliten la prevención o solución de conflictos. 

 

4.4.7.4.CONFORMACIÓN Y PARTICIPACIÓN 

 

Para el caso de la cuenca, los actores sociales e institucionales existentes podrían 

agruparse en los estamentos listados a continuación:  

➢ Organismos de gestión de los recursos naturales renovables: agua 

(SENAGUA), cuencas hidrográficas (SENAGUA, MAE e INAMHI), suelo 

(MAG), bosques (MAE);  

➢ Organismos de Gestión Ambiental: MAE, municipios, FONAG;  

➢ Organismos de Gestión Territorial: Consejo Provincial de Pichincha, 

municipios, juntas parroquiales, MAE (áreas protegidas, bosques protectores). 
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➢ Usuarios: Riego, Electricidad, Consumo humano (EMAP-Q);  

➢ Grupos Locales: Organizaciones indígenas y afro ecuatorianas, comunas, 

cooperativas, centros, entre otros; Asociaciones de propietarios; y, 

Asociaciones productivas: empresas que efectúan actividades turísticas, 

comerciales o industriales vinculadas al área de manera permanente;  

Asistencia Técnica: Organismos profesionales, organismos no gubernamentales 

(FONAG), asistencia técnica internacional; universidades y centros de investigación 

científica. 

Función dentro de la cual las universidades jueguen un papel fundamental en el estudio 

de las cuencas sub cuencas y micro cuencas, para el desarrollo del país, teniendo en 

consideración el agua como recurso vital no solo para consumo, sino también para el 

uso fundamental que es la agricultura, contamos una sub cuenca rica en agua, la cual 

debe ser aprovechada al máximo para evitar futuras, perdidas en el sector agrícola como 

ganadero a causa únicamente de la falta del recurso vital. 

 

Dentro de esto SENAGUA debería realizar una actualización de la situación de fuentes 

de agua superficial y subterránea (cuantificación, tipo fuentes, tipo contaminación, 

caudal base, calidad de agua, nivel contaminación, usos, estatal o privada, 

adjudicación, mapeo), para tener un punto de partida dentro del manejo integrado de 

los recursos hídricos, pues son ellos la instancia llamada a la protección y cuidado de 

las cuencas, sub cuencas, y micro cuencas de todo el país. 

 

4.5.ANÁLISIS DE SISTEMAS DE INFORMACIÓN GEOGRÁFICA 
 

4.5.1. SISTEMA DE CODIFICACIÓN PFAFSTETTER  

 

Es una metodología para asignar Identificadores (ID) a unidades de drenaje basado en 

la topología de la superficie o área del terreno; asigna Ids a una unidad hidrográfica 
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para relacionarla con las unidades hidrográficas que contiene y de las unidades 

hidrográficas con las que limita. 

4.5.1.1. Tipos de Unidades Hidrográficas. 

 El Sistema de delimitación y codificación de Pfafstetter considera tres tipos de 

unidades de drenaje: cuencas, intercuencas y cuencas internas.  

4.5.1.2. Cuenca 

Es un área (unidad hidrográfica) que no recibe drenaje de ninguna otra área, pero si 

contribuye con flujo a otra unidad de drenaje.  

4.5.1.3. Intercuenca  

 

Es un área (unidad de drenaje) que recibe el drenaje de otra unidad que se ubica aguas 

arriba, mediante el curso del río principal, y permite el drenaje del flujo propio y del 

que ha ingresado a esta unidad hacia la unidad de drenaje que se ubica hacia aguas 

abajo. En tal sentido una unidad de drenaje tipo intercuenca es una unidad de drenaje 

o de tránsito del río principal al cual también aporta sus propios caudales. 

4.5.1.4.Cuenca Interna 

 

Es un área de drenaje que no recibe flujo de agua de otra unidad ni contribuye con flujo 

de agua a otra unidad de drenaje o cuerpo de agua. 

4.6.Proceso de Codificación  
 

Para iniciar el proceso de codificación se debe en principio determinar el curso del río 

principal de la unidad que se va codificar. Una vez determinado el curso del río 

principal, se determinan las cuatro unidades hidrográficas de tipo cuenca, que son las 

cuatro unidades de mayor área que confluyen al río principal. Las cuatro unidades tipo 

cuenca se codifican con los dígitos pares 2, 4, 6 y 8, desde aguas abajo hacia aguas 

arriba; es decir, desde la desembocadura hacia la naciente del río principal. Las otras 

áreas de drenaje se agrupan en unidades hidrográficas de tipo intercuenca, y se 
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codifican, también desde aguas abajo (desde la confluencia) hacia aguas arriba, con los 

dígitos impares 1, 3, 5, 7 y 9. Por la metodología de delimitación y codificación de las 

unidades hidrográficas, el código 9 siempre resulta o se reserva para la unidad de 

drenaje de mayor tamaño de la parte superior de la cuenca o cabecera de cuenca la 

misma que generalmente contiene el origen del río cuya unidad de drenaje se está 

codificando. Cada una de las unidades de drenaje de tipo cuenca o intercuenca, 

delimitadas y codificadas en un determinado nivel (por ejemplo el cuarto) se pueden a 

su vez subdividir y codificar siguiendo exactamente el proceso antes descrito, de modo 

que por ejemplo la delimitación y codificación de la unidad de drenaje tipo cuenca de 

código 1524 se subdivide y codifica en nueve unidades hidrográficas, cuatro de tipo 

cuenca códigos 15242, 15244, 15246 y 15248 y cuatro de tipo intercuenca de códigos 

15241, 15243, 15245 y 15247 así como la unidad hidrográfica de cabecera de código 

15249. El mismo proceso se aplica a las unidades de tipo intercuenca, de modo que por 

ejemplo la unidad tipo intercuenca de código 1485, se subdivide en las unidades de tipo 

cuenca de códigos 14852, 14854, 14856 y 14858 y en las unidades tipo intercuenca 

14851, 14853, 14855, 14857 y 14859. Los códigos de las unidades menores deben 

llevar siempre al inicio el código o los dígitos de la unidad que lo contiene. 

4.6.1. Particularidades del Método  

 

Una particularidad del método se presenta en la codificación de las dos unidades más 

altas de la unidad hidrográfica que se está codificando. En este caso a la unidad que 

presenta mayor área de drenaje se le asigna el código “9” y a la otra, el código “8”. 

Esta particularidad del método permite identificar la cuenca donde se origina el río, que 

para el ejemplo corresponde al código 89. 
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4.7.DELIMITACIÓN DE LA CUENCA PRINCIPAL CON EL SOFWARE 

ARC GIS  
 

4.7.1. Obtención del DEM 

 

Se puede obtener un DEM a partir de un TIN (creado por medio de curvas de nivel) o 

descargar un DEM directamente desde ASTER GDEM. 

 

4.7.2.  Definir proyección del DEM 

 

Es necesario que el archivo ráster cuente con una proyección, en caso de no contar se 

la puede definir desde la caja de herramientas ArcToolbox, se define la proyección 

tanto en el sistema de coordenadas entrante (en caso de no tener) como el de salida. 

ArcToolbox > Data Management Tools > Projections and Transformations > Raster > 

Project Raster. 

 

4.7.3. Eliminar imperfecciones del DEM 

 

Una vez definida la proyección usaremos la herramienta Fill, que permite rellenar 

vacíos en la superficie del ráster para quitar imperfecciones en la información del DEM, 

tan solo es necesario trabajar con el DEM generado en el paso anterior. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Fill 

 

http://foro.acolita.com/viewtopic.php?f=2&t=58
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4.7.4. Definir la dirección de la red hídrica 

 

Por medio de la herramienta Flow Direction, crea un ráster con la dirección de flujo de 

cada una de sus celdas hasta su vecina cuesta abajo, aquí seleccionamos el ráster 

generado con Fill. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction 

 

http://i1.wp.com/www.acolita.com/wp-content/uploads/Fill-Hydrology-ArcGIS.png
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4.7.5. Determinar la acumulación la red hídrica 

 

Ahora con la herramienta Flow Accumulation, se crea un ráster del flujo acumulado 

para cada una de sus celdas, también se puede aplicar un factor de peso si es necesario, 

la entrada de esta herramienta es el archivo ráster generado con la herramienta Flow 

Direction. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation 

 

http://i0.wp.com/www.acolita.com/wp-content/uploads/Flow-Direction-Hydrology-ArcGIS.png
http://i0.wp.com/www.acolita.com/wp-content/uploads/Flow-Direction-Hydrology-ArcGIS.png
http://i0.wp.com/www.acolita.com/wp-content/uploads/Flow-Direction-Hydrology-ArcGIS.png
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4.7.6. Delimitando automáticamente la cuenca hidrográfica 

 

Para delimitar la cuenca hidrográfica se lo realiza apoyándose en las siguientes 

herramientas: 

• Basin, elabora un ráster delineando todas las cuencas hidrográficas en base a la 

red de drenaje, el ráster de entrada es el creado con la herramienta Flow Direction. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Basin 

http://i1.wp.com/www.acolita.com/wp-content/uploads/Flow-Accumulation-Hydrology-ArcGIS.png
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• Como siguiente paso ese  transforma el ráster que se generó con Basin a vector 

(shapefile), con la herramienta Raster to Polygon (Raster to Features, en versiones 

anteriores a ArcGIS 10.2.2). 

ArcToolbox > Conversion Tools > From Raster > Raster to Polygon 

• Recortar la cuenca hidrográfica, aquí solo basta con usar la herramienta Clip de 

Geoprocessing, o en su lugar seleccionar la cuenca deseada y exportar desde las 

propiedades. 

ArcToolbox > Analysis Tools > Extract > Clip 

 

4.7.7. Construir automáticamente la red hídrica 

 

Con el famoso Raster Calculator, para ello hay que tomar en cuenta de tamaño del 

pixel (tamaño del DEM), para este ejemplo al construir la red hídrica primaria se 

http://i0.wp.com/www.acolita.com/wp-content/uploads/Basin-Hydrology-ArcGIS.png
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puede determinar los valores del raster Flow Accumulation mayores a 12345, y 

para la secundaria mayores a 1234 (tanto en la primaria como secundaria jugar con 

los valores). 

• Red primaria: Flow_accumulation > 1234567 

• Red secundaria: Flow_accumulation > 1234 

ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator 

 

 

Ahora que se ha elaborado la red hídrica, convertir el ráster a shapefile con la 

herramienta Raster to Polilyne. 

ArcToolbox > Conversion Tools > From Raster > Raster to Polyline 

 

 

http://i1.wp.com/www.acolita.com/wp-content/uploads/Raster-Calculator-ArcGIS-10.png
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4.7.8. Toque finales 

 

Finalmente se procede a recortar los shapefiles de la red hídrica (construida 

anteriormente), con ayuda de la herramienta Clip, tomando como entrada la red de 

polilineas y cortar con el perímetro de la cuenca determinada anteriormente (sexto 

paso). 

ArcToolbox > Analysis Tools > Extract > Clip 

 

 

 

 

 

 

 

 

http://i1.wp.com/www.acolita.com/wp-content/uploads/Delimitar-cuenca-en-ArcGIS.png
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CONCLUSIONES 

 

➢ Una vez conocido la disponibilidad del recurso hídrico en la sub cuenca 

hidrográfica del cantón Latacunga, se puede implementar trabajos relacionados 

con el Gobierno Autónomo descentralizado en cuanto al, manejo adecuado de 

un programa de gestión del recurso hídrico enmarcado en la realidad. 

 

➢ Los diferentes estudios que ha realizado SENAGUA se lo deberían realizar a 

nivel de cuencas hidrográficas, más a nivel de límites provinciales o cantonales, 

pues el líquido vital no conoce de limitaciones administrativas. 

 

 

➢ El caudal medio de la sub cuenca del rio Cutuchi es de 10,6 m3/seg con este 

caudal podemos garantizar agua para todo el sector agrícola, teniendo en 

consideración que las precipitaciones máximas se registraron en el mes de Abril 

con 100,83 mm y las precipitaciones menores en el mes de Julio con 30,16 mm. 

 

➢ Para llenar la represa debemos llegar a una efectividad neta del 80%, sin 

embargo en el estudio con una represa a 50m de altura únicamente llegamos a 

una efectividad neta del 0,19% lo que nos indica que debemos construir una 

represa de una mayor altura para poder manejar adecuadamente el recurso vital. 
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RECOMENDACIONES 

➢ Durante el desdoblamiento del pixel tener cuidado en los cálculos 

principalmente de la tabla t. en vista que debemos calcular exactamente el error 

medio total, para evitar inconvenientes en el cálculo del volumen de agua que 

se manejara. 

➢ Elaborar una propuesta de manejo de recurso hídrico mediante geolocalización 

de las cuencas, sub cuencas y micro cuencas de la provincia, con el fin de 

obtener la caudal medio anual del recurso hídrico. 

➢ Una vez conocido el caudal medio del rio Cutuchi se debe realizar una 

planificación adecuada del manejo del Recurso Hídrico por parte de los GAD’s, 

para dotar de agua para el riego agrícola en el Cantón Latacunga. 
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